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1 Introduction 
The purpose of the Clinic Services Scheduler is to provide local agencies and clinics the 
ability to create and maintain various types of appointments for families in the WIC 
program.  WIC appointments, Nutrition Education classes, and non-WIC appointments, and 
Personal appointments appear on the clinic schedule.  

The Master Schedule screens (accessed via System Administration) are used to set up the 
clinic’s working hours and available staff.  See the SA Scheduler Screens DFDD for more 
information on establishing the clinic working hours and staff.  

Scheduler also integrates with an auto-dialer system.  At the clinic level, it is determined 
whether or not an auto-dialer is used.  If a clinic uses an auto-dialer, then WIC 
appointments and Nutrition Education classes are available for the call file. 

1.1 Interaction Between Scheduler and Clinic Services 
The Scheduler and Clinic Services modules of the WIC system work closely together.  Users 
frequently work with a family in Clinic Services and move directly to Scheduler to set up 
appointments for family members.  Likewise, users working in Scheduler can search for and 
retrieve families to schedule for appointments or nutrition education classes.   

The following business rules describe how the WIC system handles interaction between the 
Scheduler and Clinic Services: 

• If a user is viewing a family in Clinic Services and goes to Scheduler to view that 
family’s appointments, the user clicks on the family’s name in the Recent Family 
drop down list to have that same family in view when they return to Clinic Services.  
If no specific family is selected and the user clicks on the Clinic Services navigation 
button, then the user is presented with the Simple Search screen in the main panel. 

• If the user is viewing an existing family in Clinic Services that family appears in the 
recent families list if the user switches to the Scheduler.  Users can then use the 
recent families list to select that family for an appointment.  (Users also have the 
option to search for a different family for an appointment.) 

• Scheduler does not allow the user to make an appointment for a new family until 
that family is saved in Clinic Services. 

• The schedule of a disconnected clinic is locked during the hours the disconnected 
clinic is in session so that no connected PCs can schedule to that clinic while it is in 
session.   

Note: Within Scheduler, participant lists are sorted differently than they are within Clinic 
Services because the data set available does not always have the age calculated for the 
participants and age is not displayed as prevalently in Scheduler as it is in Clinic Services.  
Each system component that displays participants in lists within Scheduler has a sort order 
defined. 
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2 Navigation Panel 
The Navigation Panel contains: 

• Navigation buttons stacked starting from the bottom of the panel. 

• Multiple calendars. 

2.1 Navigation Buttons 
The navigation button labeled “Scheduler” allows the user to access the Scheduler functional 
area. 

When the user clicks on the Scheduler navigation button, 

• Navigation Panel contains multiple calendars.   See the Multiple Calendars section in 
this document for more details. 

• Main Panel contains the WIC Clinic Schedule for the current day.  See the Main Panel 
section in this document for more details. 

• Information Panel displays the System and Messages tabs by default. 

2.2 Multiple Calendars 
The Multiple Calendars is a graphic representation of calendar months.  The first month 
displayed is the current month (with the current day highlighted inside it).  The next months 
follow.  The number of months displayed is dependent on the user’s screen resolution.  The 
user selects days in these months to determine which day’s Appointment Calendar is shown 
in the Main Panel.  The user can also navigate to other months using the month spin control 
or the year spin control.  The Today button at the bottom of the Multiple Calendars can be 
selected to revert to the current day’s Appointment Calendar. 
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2.3 Saving Work 
The Scheduler area saves units of work at the appointment level.  A save confirmation pop-
up is presented to the user when a new functional area of the system is selected.Main Panel 

This panel is where all the screens described in the remaining Scheduler DFDDs are 
displayed. 
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3 Information Panel 
The Information Panel contains two tabs.  The first is entitled “System” which contains 
active “System Wide” and “Scheduler” type system messages.  The second is entitled 
“Messages” which contains warning and error messages associated with the main panel 
screen.  These are described in the System Overview DFDD. 
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4 Menu Bar 
The Scheduler Menu Bar is visible at all times and is found at the top of the screen. 

 

Control Description 

File Select File to display File menu options. See File Menu section for 
more information. 

 Type Menu Item 

 Hot Key Alt + F 

Printouts Select Printouts to display the options for which a user can print 
the clinic schedule for a particular day.  Note:  These are not 
participant notices.  These are UI outputs related to the 
scheduler.  

• Daily Calendar  

• Clinic Roster  

 Type  Menu Item  

 Hot Key Alt + O 

Help Select Help to display Help menu options. See Help Menu section 
for more information. 

 Type  Menu Item 

 Hot Key Alt + H 

4.1 File Menu 
The File menu is visible at all times, giving access to common File functions.  

 

Control Description 

Change Clinic Select Change Clinic to select a different clinic. 

 Type Menu Item 

 Hot Key Ctrl + G 

Exit Select Exit to exit the application. 

 Type Menu Item 

 Hot Key Alt + F4 
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4.1.1 Change Clinic 
This pop-up is used to change the clinic that the user is logged onto.   At user logon, the 
user selects a clinic.  The access for the user is based on the clinic. 

 

 

Control Description 

unlabeled The unlabeled data grid within the Change Clinic pop-up window 
allows the user to select another clinic.  The user sees clinics that 
he or she has access rights to see.  The user highlights the clinic 
that he or she wants to go to and clicks the OK command button. 

 Type Read-Only Data Grid 

 Display Yes 

LA-Clinic number This is the local agency-clinic number. 

 Format Z9-ZZZZ9 Calculated No 

Clinic name This is the name of the clinic. 

 Format Alphanumeric Calculated No 

OK Clicking the OK button changes the clinic and returns the user 
back to the main application. 

 Type Command Button 

 Hot Key Alt + O 

Cancel Clicking the Cancel button returns the user back to the main 
application. 

 Type Command Button 

 Hot Key Alt + L 
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4.2 Printouts Menu 
The Printouts menu is visible at all times, giving access to printouts associated with the 
scheduler. 

 

 

Control Description 

Daily Calendar Select the Daily Calendar menu item to print the daily calendar 
for the calendar day that is currently displayed in the calendar. 

 Type Menu Item 

 Hot Key None 

Clinic Roster Select the Clinic Roster menu item to print the clinic roster for 
the calendar day that is currently displayed in the calendar. 

 Type Menu Item 

 Hot Key None 

4.2.1 Daily Calendar (Static) 
The Daily Calendar is a UI Output that shows the clinic calendar like it is shown on the 
screen.  The user selects columns and dates to print based on the Page Setup dialog box 
that is part of the calendar control.  (The Page Setup Dialog box is part of the purchased 
calendar control.  No customization is available for this dialog box.  Refer to Page Setup for 
more information about this dialogue box.)  This UI Output would allow for paper scheduling 
if clinic flow or staffing requires.  The minimum appointment durations and the way that the 
clinic schedules appointments dictates how much of the information about an individual 
appointment can be seen.  For a WIC appointment, where there is space within the 
appointment period, the endorser’s name, the appointment type, the participant’s names, 
and the appointment notes are displayed. For Nutrition Education Class Appointments or 
Non-WIC Appointments, only the name of the class or appointment is indicated.   

Note: Because the printing of the calendar is a function of the purchased calendar control, 
this UI output is not available for state customization through System Administration. 

4.2.1.1 Language: English 
The daily calendar is available in English only. 
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4.2.1.2 Daily Calendar Mockup 

 

Business Rules 

1. This UI output is landscape. 

2. For WIC appointments, print the WIC Appointment’s Subject (Appointment.Subject), 
see WIC Appointment in the SC 1 DFDD for additional details. 

3. For NE appointments, print the Nutrition Education Class Appointment’s Subject  
(Appointment.Subject), see Nutrition Education Class Appointment in the SC1 DFDD 
for additional details. 

4. For Non-WIC or Personal appointments, print the following information 
(Appointment.Subject):   

Subject of the appointment (Appointment.Subject) 

4.2.2 Page Setup 
The Page Setup dialogue box is used to select the format styles, paper size, and the 
columns that are printed on the Daily Calendar.  As a part of the purchased calendar 
control, no customization will occur with this dialogue box.   
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The Format tab of the Page Setup dialogue box is used to define the Style of the document.  
The WIC Daily Calendar is the style that produces the Daily Calendar.  It is unlikely that any 
additional options will be utilized by the WIC staff, but as part of the calendar control, the 
additional options are depicted too. 
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The Paper tab of the Page Setup dialogue box is used to select the paper and page 
orientation.  Staff will ordinarily not change the default settings, but it is available if 
necessary for the printing situation. 
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The Resources tab of the Page Setup dialogue box is used to select the columns that are 
printed on the Daily Calendar.  Resources are equal to columns in the calendar.  The user 
has the ability to print all resources (columns) on one page or define how many resources 
(columns) per page, print only the resources (columns) that are currently in view on the 
calendar, or print the resources (columns) selected through the custom collection data grid.   
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4.2.3 Clinic Roster Selection Pop-Up 
The Clinic Roster Selection Pop-up allows staff to select specific columns to print on the 
Clinic Roster. 

 

 

Control Description 

Print the following 
columns on the Clinic 
Roster: - All Columns 

Checking this checkbox allows the printing of all columns on the 
Clinic Roster.   

 

 Type Check Box 

 Display Only No Calculated No 

 DB Column Not Stored 

Print the following 
columns on the Clinic 
Roster: - (additional 
check boxes) 

Checking this checkbox allows the printing of that specific 
column on the Clinic Roster. 

 Type Check Box 

 Display Only No Calculated No 

 DB Column Not Stored 

OK The OK button allows the printing of the Clinic Roster with the 
selected columns. 

 Type Command Button 

 Hot Key Alt + O 
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Control Description 

Cancel The Cancel button returns the user to the WIC Clinic Schedule. 

 Type Command Button 

 Hot Key Alt + L 

 
Business Rules 

1. Display all active columns on the schedule for the day specified.   

2. Display an error message if no check boxes are selected and user clicks OK. 

3. If the user selects the “All Columns” checkbox, then the system automatically selects 
all subsequent checkboxes. 

4. If the user unselects the “All Columns” checkbox, then the system automatically 
unselects all subsequent checkboxes.   

5. If any of the checkboxes except the “All Columns” checkbox are unselected, then 
unselect the “All Columns” checkbox.   

6. If the user selects all of the checkboxes except the “All Columns” checkbox, then the 
system automatically selects the “All Columns” checkbox. 

7. Display “All Columns” as the top checkbox, then sort remaining checkboxes in 
alphabetical order. 

 
Developer Notes 

1.  

4.2.4 Clinic Roster (Static) 
The Clinic Roster is often printed out ahead of the clinic day and used for a call reminder 
listing or for clinic preparation.  This may also be printed if there is suddenly a need to 
cancel a number of appointments.  It is likely that rescheduling will occur when the family 
next contacts the WIC office or when a rescheduled day is established.  The clinic roster is 
sorted by the Appointment Time. 

4.2.4.1 Language: English 
The clinic roster is available in English only. 



MPSC WIC Data System Project SC 0 Scheduler Overview 

4.2.4.2 Clinic Roster Mockup 

 

 

Business Rules 

1. This UI output is landscape. 

2. Page numbering in the output should appear in the footer-right in the format "Page x 
of y". 

3. Print the columns selected in the Clinic Roster Selection pop-up. 

4. LA-Clinic header =   Clinic.LA_ID, Clinic.FFClinicID 
5. Clinic Date = MasterSchedule.MasterScheduleDt 
6. Appt Time = Appointment.StartTime 

7. The participant name is 
FamilyMember.FirstName+FamilyMember.MiddleName+FamilyMember.LastName+Fa
milyMember.LastNameSuffix 

8. Person ID = FamilyMember.FFMemberID 

9. DOB is Participant.BirthDt.  Display as mm/dd/yyyy. 

10. The endorser name is 
FamilyMember.FirstName+FamilyMember.MiddleName+FamilyMember.LastName 
where FamilyMember.ParentGuardianIn = “Y” 

11. Family Phone = BenefitFamily.HomePhoneAreaCd + 

BenefitFamily.HomePhoneNr, Display as (999) 999-9999 

Note:  If BenefitFamily.DoNotCallIn = Yes, then display “Do Not Call” instead of the 
phone number. 

12. Appt Type = Appointment.AppointmentTypeCd (Short description for WIC 
Appointments only, no Nutrition Education Class Appointments) 

13. Column = AppointmentColumn.MSC_ID 

14. Language = BenefitFamily.SpokenLanguageCd 

15. Indicators = RiskHeader.HighRiskIn, FamilyMember.SpecialNeeds,  

BenefitFamily.NeedInterpreterIn, Participant.MiscarriageIn 

16. Notes = Appointment.Note 

17. Result and Response columns are present on the UI output only if the 
CClinic.AutoDialerIn is marked on the Clinic Details screen.  

18. Result = Appointment.AutoDialResult 
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Business Rules 
19. Response = Appointment.AutoDialResponse 

20. Sort by Appointment Time, Column, Endorser Name (full name=First Middle Last 
Suffix), Participant Name (full name=First Middle Last Suffix). 
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4.3 Help Menu 
The Help menu is visible at all times, giving access to user help and system version 
information. 

 

 

Control Description 

User Help Clicking the User Help menu item allows the user to view the 
current version of the application user help.  This opens a Help 
window as described in the System Overview DFDD. 

 Type Menu Item 

 Hot Key None 

About (System Name) Clicking the About (parameter) menu item allows the user to 
view version and system information. 

 Type Menu Item 

 Hot Key None 

4.3.1 About (System Name) Pop-up 
This pop-up provides the user with the version number of the application and allows for 
assemblies to be viewed as needed. 
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Control Description 

Version The version number that is displayed shows the version of the 
application that is currently being used (as defined in system 
parameter). 

 Type Text Box 

 Required NA 

 Length NA 

 Validation NA 

 Display Only Yes Calculated No 

 DB Column Not Stored 

 

The CIBER logo appears for branding purposes.  This is the 
company that developed the application. 

 Type Text Box 

 Required NA 

 Length NA 

 Validation NA 

 Display Only Yes Calculated No 

 DB Column NA 

Show Assemblies/Hide 
Assemblies 

By default, the About (System Name) Pop-Up displays the 
version number of the application.  Clicking the Show 
Assemblies command button displays system assemblies.  
Clicking the Hide Assemblies command button returns to the 
default view. 

 Type Command Button 

 Hot Key Alt + M 

Close Clicking the Close command button closes the About (system 
name) pop-up and returns the user to the Clinic Services 
screens. 

 Type Command Button 

 Hot Key Alt + C 

 
Business Rules 

1.  

 
Developer Notes 

1.  
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5 Tool Bar (and Header Information) 
The Scheduler Tool Bar is visible at all times, giving access to frequently used functions and 
screens, including the Clinic. 

 

 

Control Description 

 Clicking this Save icon saves any changes that were made on the 
current screen to the database.   

 Type Command Button 

 Hot Key None 

 
Clicking this New Appointment icon shows a pop-up where the 
user selects and appointment type and then shows the type of 
appointment editor pop-up that is appropriate for the 
appointment type selected. 

 Type Command Button 

 Hot Key None 

 
Clicking this Find Open Appointment icon opens the Find Open 
Appointment Slot pop-up as specified in the SC 1 Scheduler – 
Appointment Screens DFDD. The most recently viewed family’s 
Family Preferences appear by default in the Find Open 
Appointment Slot pop-up.  If no family was recently viewed then 
family information is not shown.  The Find Open Appointment 
Slot pop-up selection criteria also display.   

 Type Command Button 

 Hot Key None 

 
Clicking the arrow of this Recent Family icon allows the user to 
access a recent family by selecting from the list of 10 most 
recently accessed families. 

 Type Command Button 

 Hot Key None 

 
Clicking this Income Guideline icon will display the Income 
Guidelines Reference pop-up screen. 

 Type Command Button 

 Hot Key None 
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Control Description 

LA/Clinic This is a list box of the agencies and clinics that the user has 
security access to.   

 Type List Box 

 Required Yes 

 DB Column LocalAgency.FFLocalAgencyID 

 Code ID ClinicSchedule.ClnID 

 
The refresh timer tells a user how long it has been since the 
Scheduler data has been refreshed.  After the number of minutes 
in the system parameter, Scheduler.RefreshMinutes, the time 
turns red and a reminder informational message is placed in the 
Messages tab in the Information Panel. 

 Type Text Box 

 Required NA 

 Length NA 

 Validation 00:00:00 

 Display Only Yes Calculated Yes 

 DB Column Not Stored 

 
Clicking the Date Range Quick Select icon allows the user to 
quickly move to a predefined period of time on the WIC Clinic 
Schedule.  The schedule is refreshed and the dates are 
displayed. 

 Type Command Button 

 Hot Key None 

Start Date This is the first date of retrieved data that Scheduler has 
available to the user.   

 Type Date Picker 

 Required Yes 

 Display Only No Calculated No 

 DB Column Not Stored 

End Date This is the end date of retrieved data that Scheduler has 
available to the user.   

 Type Date Picker 

 Required Yes 

 Display Only No Calculated No 

 DB Column Not Stored 
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Control Description 

 
Clicking this Refresh icon refreshes the displayed schedule.   

 Type Command Button 

 Hot Key None 

 
Business Rules 

1. For LA/Clinic Listbox, if user is currently connected, apply user security, then make 
read only all clinics that are operating in Disconnected mode and are open today.  

2. For LA/Clinic Listbox, if user is currently disconnected, apply user security, then make 
read only all clinics except the disconnected clinic that the user is logged into. 

3. When the application starts, the Start Date and End Date default to the number of 
days defined in the system parameter, Scheduler.AppointmentsNoDaysToDisplay. 

4. The Date Range Quick Select selections include:  Just Today, Today to 2 weeks from 
now, Today to 4 weeks from now, Today to 6 weeks from now, 2-3 weeks from now, 
4-5 weeks from now, 6-11 weeks from now, and 12-16 weeks from now. 

5. When the Date Range Quick Select selections are used, the WIC Clinic Schedule is 
refreshed and the new date range is presented to the user.  The Start Date and End 
Date fields reflect the new selection. 

6. The user can narrow or widen the date range by changing the Start Date and End 
Date.  Performance may be impacted if too large of a range is selected. 

7. After changing either Start Date or End Date, the user must press the refresh button 
to refresh the data according to the new date range. 

8. Display an error message when the user clicks the Refresh button if the End Date is 
prior to Start Date. 

9. Display an error message if the End Date is more than the system parameter, 
Scheduler.MaxRetrievalDays, after the Start Date. 

10. Dates inside the selected date range appear red (Closed) or black (Open) on the 
Navigation Panel calendars based on their closed or open status. 

11. Dates outside the selected date range appear gray on the Navigation Panel calendars. 

12. If the user clicks on a date on the calendars that is not included in the currently 
selected date range, present the following text in the main panel “This date is outside 
the currently selected date range.” 

13. The application continues to use the selected date range for the user until the user 
moves to a different functional area of the application or the application is closed.  
When the user returns to Scheduler, the dates return to the default date range defined 
in the system parameter, Scheduler.AppointmentsNoDaysToDisplay. 

14. When trying to access a family’s record in Clinic Services using the Recent Families 
list, the system evaluates if the user has view or update rights to the selected family. 

a. If the user has view or update rights for the family, then the system changes to 
the Clinic Services functional area and displays the Family screen for the 
selected family. 

b. If the user does not have view or update rights for the family, then the system 
displays an informational message indicating that they don’t have user 
permissions for this family.  The user remains on the WIC Clinic Schedule.   
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Developer Notes 

1. Connected mode = Clinic.AllowLoginIn = 1 and Clinic.NDTComputerNm = null and 
Clinic.NDTInstanceNm = null 

2. Disconnected mode = Clinic.DisconnectedClinicIn = 1 or Clinic.AllowLoginIn = 0  

3. Open today = MasterScheduleDt = today’s date and the ClosedReason and 
HolidayName fields are null or empty 
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	 Daily Calendar 
	 Clinic Roster 
	Type 
	Menu Item 
	Hot Key
	Alt + O
	Help
	Select Help to display Help menu options. See Help Menu section for more information.
	Type 
	Menu Item
	Hot Key
	Alt + H
	4.1 File Menu

	The File menu is visible at all times, giving access to common File functions. 
	Control
	Description
	Change Clinic
	Select Change Clinic to select a different clinic.
	Type
	Menu Item
	Hot Key
	Ctrl + G
	Exit
	Select Exit to exit the application.
	Type
	Menu Item
	Hot Key
	Alt + F4
	4.1.1 Change Clinic

	This pop-up is used to change the clinic that the user is logged onto.   At user logon, the user selects a clinic.  The access for the user is based on the clinic.
	Control
	Description
	unlabeled
	The unlabeled data grid within the Change Clinic pop-up window allows the user to select another clinic.  The user sees clinics that he or she has access rights to see.  The user highlights the clinic that he or she wants to go to and clicks the OK command button.
	Type
	Read-Only Data Grid
	Display
	Yes
	LA-Clinic number
	This is the local agency-clinic number.
	Format
	Z9-ZZZZ9
	Calculated
	No
	Clinic name
	This is the name of the clinic.
	Format
	Alphanumeric
	Calculated
	No
	OK
	Clicking the OK button changes the clinic and returns the user back to the main application.
	Type
	Command Button
	Hot Key
	Alt + O
	Cancel
	Clicking the Cancel button returns the user back to the main application.
	Type
	Command Button
	Hot Key
	Alt + L
	4.2 Printouts Menu

	The Printouts menu is visible at all times, giving access to printouts associated with the scheduler.
	Control
	Description
	Daily Calendar
	Select the Daily Calendar menu item to print the daily calendar for the calendar day that is currently displayed in the calendar.
	Type
	Menu Item
	Hot Key
	None
	Clinic Roster
	Select the Clinic Roster menu item to print the clinic roster for the calendar day that is currently displayed in the calendar.
	Type
	Menu Item
	Hot Key
	None
	4.2.1 Daily Calendar (Static)

	The Daily Calendar is a UI Output that shows the clinic calendar like it is shown on the screen.  The user selects columns and dates to print based on the Page Setup dialog box that is part of the calendar control.  (The Page Setup Dialog box is part of the purchased calendar control.  No customization is available for this dialog box.  Refer to Page Setup for more information about this dialogue box.)  This UI Output would allow for paper scheduling if clinic flow or staffing requires.  The minimum appointment durations and the way that the clinic schedules appointments dictates how much of the information about an individual appointment can be seen.  For a WIC appointment, where there is space within the appointment period, the endorser’s name, the appointment type, the participant’s names, and the appointment notes are displayed. For Nutrition Education Class Appointments or Non-WIC Appointments, only the name of the class or appointment is indicated.  
	Note: Because the printing of the calendar is a function of the purchased calendar control, this UI output is not available for state customization through System Administration.
	4.2.1.1 Language: English

	The daily calendar is available in English only.
	4.2.1.2 Daily Calendar Mockup

	Business Rules
	1. This UI output is landscape.
	2. For WIC appointments, print the WIC Appointment’s Subject (Appointment.Subject), see WIC Appointment in the SC 1 DFDD for additional details.
	3. For NE appointments, print the Nutrition Education Class Appointment’s Subject  (Appointment.Subject), see Nutrition Education Class Appointment in the SC1 DFDD for additional details.
	4. For Non-WIC or Personal appointments, print the following information (Appointment.Subject):  
	Subject of the appointment (Appointment.Subject)
	4.2.2 Page Setup

	The Page Setup dialogue box is used to select the format styles, paper size, and the columns that are printed on the Daily Calendar.  As a part of the purchased calendar control, no customization will occur with this dialogue box.  
	The Format tab of the Page Setup dialogue box is used to define the Style of the document.  The WIC Daily Calendar is the style that produces the Daily Calendar.  It is unlikely that any additional options will be utilized by the WIC staff, but as part of the calendar control, the additional options are depicted too.
	The Paper tab of the Page Setup dialogue box is used to select the paper and page orientation.  Staff will ordinarily not change the default settings, but it is available if necessary for the printing situation.
	The Resources tab of the Page Setup dialogue box is used to select the columns that are printed on the Daily Calendar.  Resources are equal to columns in the calendar.  The user has the ability to print all resources (columns) on one page or define how many resources (columns) per page, print only the resources (columns) that are currently in view on the calendar, or print the resources (columns) selected through the custom collection data grid.  
	4.2.3 Clinic Roster Selection Pop-Up

	The Clinic Roster Selection Pop-up allows staff to select specific columns to print on the Clinic Roster.
	Control
	Description
	Print the following columns on the Clinic Roster: - All Columns
	Checking this checkbox allows the printing of all columns on the Clinic Roster.  
	Type
	Check Box
	Display Only
	No
	Calculated
	No
	DB Column
	Not Stored
	Print the following columns on the Clinic Roster: - (additional check boxes)
	Checking this checkbox allows the printing of that specific column on the Clinic Roster.
	Type
	Check Box
	Display Only
	No
	Calculated
	No
	DB Column
	Not Stored
	OK
	The OK button allows the printing of the Clinic Roster with the selected columns.
	Type
	Command Button
	Hot Key
	Alt + O
	Cancel
	The Cancel button returns the user to the WIC Clinic Schedule.
	Type
	Command Button
	Hot Key
	Alt + L
	Business Rules
	1. Display all active columns on the schedule for the day specified.  
	2. Display an error message if no check boxes are selected and user clicks OK.
	3. If the user selects the “All Columns” checkbox, then the system automatically selects all subsequent checkboxes.
	4. If the user unselects the “All Columns” checkbox, then the system automatically unselects all subsequent checkboxes.  
	5. If any of the checkboxes except the “All Columns” checkbox are unselected, then unselect the “All Columns” checkbox.  
	6. If the user selects all of the checkboxes except the “All Columns” checkbox, then the system automatically selects the “All Columns” checkbox.
	7. Display “All Columns” as the top checkbox, then sort remaining checkboxes in alphabetical order.
	Developer Notes
	1. 
	4.2.4 Clinic Roster (Static)

	The Clinic Roster is often printed out ahead of the clinic day and used for a call reminder listing or for clinic preparation.  This may also be printed if there is suddenly a need to cancel a number of appointments.  It is likely that rescheduling will occur when the family next contacts the WIC office or when a rescheduled day is established.  The clinic roster is sorted by the Appointment Time.
	4.2.4.1 Language: English

	The clinic roster is available in English only.
	4.2.4.2 Clinic Roster Mockup

	Business Rules
	1. This UI output is landscape.
	2. Page numbering in the output should appear in the footer-right in the format "Page x of y".
	3. Print the columns selected in the Clinic Roster Selection pop-up.
	4. LA-Clinic header =   Clinic.LA_ID, Clinic.FFClinicID
	5. Clinic Date = MasterSchedule.MasterScheduleDt
	6. Appt Time = Appointment.StartTime
	7. The participant name is FamilyMember.FirstName+FamilyMember.MiddleName+FamilyMember.LastName+FamilyMember.LastNameSuffix
	8. Person ID = FamilyMember.FFMemberID
	9. DOB is Participant.BirthDt.  Display as mm/dd/yyyy.
	10. The endorser name is FamilyMember.FirstName+FamilyMember.MiddleName+FamilyMember.LastName where FamilyMember.ParentGuardianIn = “Y”
	11. Family Phone = BenefitFamily.HomePhoneAreaCd +
	BenefitFamily.HomePhoneNr, Display as (999) 999-9999
	Note:  If BenefitFamily.DoNotCallIn = Yes, then display “Do Not Call” instead of the phone number.
	12. Appt Type = Appointment.AppointmentTypeCd (Short description for WIC Appointments only, no Nutrition Education Class Appointments)
	13. Column = AppointmentColumn.MSC_ID
	14. Language = BenefitFamily.SpokenLanguageCd
	15. Indicators = RiskHeader.HighRiskIn, FamilyMember.SpecialNeeds, 
	BenefitFamily.NeedInterpreterIn, Participant.MiscarriageIn
	16. Notes = Appointment.Note
	17. Result and Response columns are present on the UI output only if the CClinic.AutoDialerIn is marked on the Clinic Details screen. 
	18. Result = Appointment.AutoDialResult
	19. Response = Appointment.AutoDialResponse
	20. Sort by Appointment Time, Column, Endorser Name (full name=First Middle Last Suffix), Participant Name (full name=First Middle Last Suffix).
	4.3 Help Menu

	The Help menu is visible at all times, giving access to user help and system version information.
	Control
	Description
	User Help
	Clicking the User Help menu item allows the user to view the current version of the application user help.  This opens a Help window as described in the System Overview DFDD.
	Type
	Menu Item
	Hot Key
	None
	About (System Name)
	Clicking the About (parameter) menu item allows the user to view version and system information.
	Type
	Menu Item
	Hot Key
	None
	4.3.1 About (System Name) Pop-up

	This pop-up provides the user with the version number of the application and allows for assemblies to be viewed as needed.
	Control
	Description
	Version
	The version number that is displayed shows the version of the application that is currently being used (as defined in system parameter).
	Type
	Text Box
	Required
	NA
	Length
	NA
	Validation
	NA
	Display Only
	Yes
	Calculated
	No
	DB Column
	Not Stored
	The CIBER logo appears for branding purposes.  This is the company that developed the application.
	Type
	Text Box
	Required
	NA
	Length
	NA
	Validation
	NA
	Display Only
	Yes
	Calculated
	No
	DB Column
	NA
	Show Assemblies/Hide Assemblies
	By default, the About (System Name) Pop-Up displays the version number of the application.  Clicking the Show Assemblies command button displays system assemblies.  Clicking the Hide Assemblies command button returns to the default view.
	Type
	Command Button
	Hot Key
	Alt + M
	Close
	Clicking the Close command button closes the About (system name) pop-up and returns the user to the Clinic Services screens.
	Type
	Command Button
	Hot Key
	Alt + C
	Business Rules
	Developer Notes
	5 Tool Bar (and Header Information)
	The Scheduler Tool Bar is visible at all times, giving access to frequently used functions and screens, including the Clinic.
	Control
	Description
	Clicking this Save icon saves any changes that were made on the current screen to the database.  
	Type
	Command Button
	Hot Key
	None
	Clicking this New Appointment icon shows a pop-up where the user selects and appointment type and then shows the type of appointment editor pop-up that is appropriate for the appointment type selected.
	Type
	Command Button
	Hot Key
	None
	Clicking this Find Open Appointment icon opens the Find Open Appointment Slot pop-up as specified in the SC 1 Scheduler – Appointment Screens DFDD. The most recently viewed family’s Family Preferences appear by default in the Find Open Appointment Slot pop-up.  If no family was recently viewed then family information is not shown.  The Find Open Appointment Slot pop-up selection criteria also display.  
	Type
	Command Button
	Hot Key
	None
	Clicking the arrow of this Recent Family icon allows the user to access a recent family by selecting from the list of 10 most recently accessed families.
	Type
	Command Button
	Hot Key
	None
	Clicking this Income Guideline icon will display the Income Guidelines Reference pop-up screen.
	Type
	Command Button
	Hot Key
	None
	LA/Clinic
	This is a list box of the agencies and clinics that the user has security access to.  
	Type
	List Box
	Required
	Yes
	DB Column
	LocalAgency.FFLocalAgencyID
	Code ID
	ClinicSchedule.ClnID
	The refresh timer tells a user how long it has been since the Scheduler data has been refreshed.  After the number of minutes in the system parameter, Scheduler.RefreshMinutes, the time turns red and a reminder informational message is placed in the Messages tab in the Information Panel.
	Type
	Text Box
	Required
	NA
	Length
	NA
	Validation
	00:00:00
	Display Only
	Yes
	Calculated
	Yes
	DB Column
	Not Stored
	Clicking the Date Range Quick Select icon allows the user to quickly move to a predefined period of time on the WIC Clinic Schedule.  The schedule is refreshed and the dates are displayed.
	Type
	Command Button
	Hot Key
	None
	Start Date
	This is the first date of retrieved data that Scheduler has available to the user.  
	Type
	Date Picker
	Required
	Yes
	Display Only
	No
	Calculated
	No
	DB Column
	Not Stored
	End Date
	This is the end date of retrieved data that Scheduler has available to the user.  
	Type
	Date Picker
	Required
	Yes
	Display Only
	No
	Calculated
	No
	DB Column
	Not Stored
	Clicking this Refresh icon refreshes the displayed schedule.  
	Type
	Command Button
	Hot Key
	None
	Business Rules
	1. For LA/Clinic Listbox, if user is currently connected, apply user security, then make read only all clinics that are operating in Disconnected mode and are open today. 
	2. For LA/Clinic Listbox, if user is currently disconnected, apply user security, then make read only all clinics except the disconnected clinic that the user is logged into.
	3. When the application starts, the Start Date and End Date default to the number of days defined in the system parameter, Scheduler.AppointmentsNoDaysToDisplay.
	4. The Date Range Quick Select selections include:  Just Today, Today to 2 weeks from now, Today to 4 weeks from now, Today to 6 weeks from now, 2-3 weeks from now, 4-5 weeks from now, 6-11 weeks from now, and 12-16 weeks from now.
	5. When the Date Range Quick Select selections are used, the WIC Clinic Schedule is refreshed and the new date range is presented to the user.  The Start Date and End Date fields reflect the new selection.
	6. The user can narrow or widen the date range by changing the Start Date and End Date.  Performance may be impacted if too large of a range is selected.
	7. After changing either Start Date or End Date, the user must press the refresh button to refresh the data according to the new date range.
	8. Display an error message when the user clicks the Refresh button if the End Date is prior to Start Date.
	9. Display an error message if the End Date is more than the system parameter, Scheduler.MaxRetrievalDays, after the Start Date.
	10. Dates inside the selected date range appear red (Closed) or black (Open) on the Navigation Panel calendars based on their closed or open status.
	11. Dates outside the selected date range appear gray on the Navigation Panel calendars.
	12. If the user clicks on a date on the calendars that is not included in the currently selected date range, present the following text in the main panel “This date is outside the currently selected date range.”
	13. The application continues to use the selected date range for the user until the user moves to a different functional area of the application or the application is closed.  When the user returns to Scheduler, the dates return to the default date range defined in the system parameter, Scheduler.AppointmentsNoDaysToDisplay.
	14. When trying to access a family’s record in Clinic Services using the Recent Families list, the system evaluates if the user has view or update rights to the selected family.
	a. If the user has view or update rights for the family, then the system changes to the Clinic Services functional area and displays the Family screen for the selected family.
	b. If the user does not have view or update rights for the family, then the system displays an informational message indicating that they don’t have user permissions for this family.  The user remains on the WIC Clinic Schedule.  
	Developer Notes
	1. Connected mode = Clinic.AllowLoginIn = 1 and Clinic.NDTComputerNm = null and Clinic.NDTInstanceNm = null
	2. Disconnected mode = Clinic.DisconnectedClinicIn = 1 or Clinic.AllowLoginIn = 0 
	3. Open today = MasterScheduleDt = today’s date and the ClosedReason and HolidayName fields are null or empty

